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Chapter 1. Introduction
1.1. General Information

Two steps are required in adding a corpus to the MPI Archive. The first involves creating the corpus, editing
the metadata and converting it into an archivable format using ARBIL(Archive Builder) while the second
involves exporting the created/edited corpus to the archive using LAMUS .

This manual describes in detail the first step i.e. Arbil. For the second step, Lamus, please refer to the
LAMUS manual [http://www.lat-mpi.eu/tools/lamus/]).

The MPI Archive can ONLY accept corpora which are in the .IMDI format. By creating a corpus through
Arbil, you create an IMDI file ready to be exported to the Archive.

Arbil allows you to view all the corpora in the Archive or any other remote location (provided you have
access rights).

Corpora from the archive can also be edited through Arbil. If the changes are to be implemented they have
to go through Lamus.

In short, Arbil allows you to:

1) View the Archive

2) Import metadata from the Archive & edit.

3) Create new corpora, with new metadata and media files.

4) Export the IMDI files, ready to be archived

Changes you make to corpora imported from the Archive will not affect the Archive directly, as Arbil
merely allows you to make changes on a local level, and not to the Archive itself. If you want to upload
your changes to the archive, you must export them to LAMUS, which in turn, allows you to submit corpora
into the archive.

Arbil is the next generation of the IMDI Editor with a more powerful user interface and functionality. This
manual contains detailed information on how to use Arbil: create new corpus structures/session nodes, and
modify existing corpora. It does not explain the internal structure of IMDI (for more information on the
IMDI metadata set, please see the LAT website [http://www.lat-mpi.eu/tools/imdi/]).

For a less detailed program description, see the Arbil User Guide [http://www.lat-mpi.eu/tools/arbil/].

We encourage you to provide feedback, comments, and suggestions so that we can improve the
documentation to better meet your needs. Also, in case of problems that are not addressed anywhere in this
guide, please use the Arbil Forum [http://tla.mpi.nl/tools/tla-tools/arbil].

1.2. Overview
The way you start working on your data is twofold:

a) you either create a new corpus or

b) make a copy of an already existing corpus or its branch from the server and edit it. Either way, the files
you create/edit will be saved on your computer (in the so called Local Corpus). This enables you to work
off-line in remote locations while still in the field. Changes you make in Arbil will not affect the archive.

http://www.lat-mpi.eu/tools/lamus/
http://www.lat-mpi.eu/tools/lamus/
http://www.lat-mpi.eu/tools/imdi/
http://www.lat-mpi.eu/tools/imdi/
http://www.lat-mpi.eu/tools/arbil/
http://www.lat-mpi.eu/tools/arbil/
http://tla.mpi.nl/tools/tla-tools/arbil
http://tla.mpi.nl/tools/tla-tools/arbil
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Arbil consists of 6 working areas as shown in the figure below:

- 1) The Remote Corpus contains locations from the Language Archive. This is where you can view corpora
and choose to import.

- 2) The Menu Bar allows you to access the main commands

- 3) The Local Corpus contains the user's main working area. This is where corpora from the Remote
Corpus can be imported and edited. It's also used for creating new corpora.

- 4) The Files /Favourites (Working Directories). This is where you can link directories from your
computer to Arbil in order to import media files and create favourite metadata items.

- 5) The Preview Area shows metadata of the selected node (In the figure below, it displays the details for
"New Corpus"). It changes every time a new node is selected.

- 6) The Table Area is where several nodes can be opened, compared, and modified at the same time (In
the figure below, the three nodes from the Local Corpus are placed in a table in this area)

Note: You can customise the size of these panes. To make a window larger or smaller place the pointer on
the border and drag it in the direction in which you want the window to expand or contract. It is also possible
to hide the preview area by unchecking the show selection preview from the options menu.

Figure 1.1. Arbil workspace
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1.3. Work flow
When working with Arbil, you have to decide whether you are going to work on an existing corpus from
the Remote Corpus or create a new corpus. Assuming that you intend to edit metadata in the Archive and
add additional media files, you follow the steps 1-6 below.

The Arbil work flow for editing a corpus is as follows:

1) Browse the Remote Corpus and locate the corpus which you intend to edit; drag it from the Remote
Corpus pane into the Local Corpus pane so as to import it.

2) Now that the corpus is located in the Local Corpus, you may edit it freely. To edit the metadata, drag
the node into the Table Area (6, image 1.1 ) and edit the fields accordingly (editing can also be done in an
external editor). This can be done with several corpora/sessions at once.

3) In order to add resources to sessions (e.g. media files and annotations), you must set up a working directory
which links a folder on your computer to Arbil. This means that any media files in this folder will appear
in the Working directory area so that Resource files can be added to the sessions of a corpus in your Local
Corpus. To add files to your new corpus, drag and drop them from the files to the local corpus . Now you
can edit the metadata following step 2.

4) Stored session elements, such as common actors, can be added to the local corpus from the favourites.

5) Once your metadata have been edited correctly and your desired media files have been added to your
sessions, you can export the node to a directory (folder) on your computer.

In order to create a new node, add a node in the Local Corpus and follow the same steps.

Note: This is as far as you can get using Arbil.

6) Once the work is finished, Open Lamus [http://www.lat-mpi.eu/tools/lamus/] and import the directory
(folder) which contains the corpora. It will then be uploaded to the archive.

Corpus and session nodes are easily edited directly in Arbil (see chapter 4 and chapter 5) but they can also
be worked on in an external editor (such as Microsoft Excel or another spreadsheet program) see 7.3.

Figure 1.2. Arbil Work flow

http://www.lat-mpi.eu/tools/lamus/
http://www.lat-mpi.eu/tools/lamus/
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In Arbil all work on corpora and sessions takes place in the Local Corpus tree. The various import, export,
and edit operations displayed in the figure above, can usually be triggered by right-clicking on elements in
the Local Corpus, or via "drag and drop" (e.g.. clicking on an element in the Remote Corpus, holding the
mouse key, and dragging the element to the Local Corpus, or to a corpus node within the Local Corpus).
Media files (i. e. audio and video recordings) and written resources can also be added to sessions via "drag
and drop" from the Working Directories tree in the Files tab. Only for importing previously exported sessions
to the local corpus root one has to access the File menu in Arbil's menu bar.

1.4. Arbil icons
The following table defines graphical icons used by Abril:

 The top node of the Remote Corpus tree (read only)

 The top node of the Local Corpus tree (contains local files)

 Top node of the Working Directories tree (short cuts of files in the Local Corpus)

 The file is in the Local Corpus (local file)

 The file is on the remote server (read only)

 The file is located in the local corpus but has been imported from the remote server

 Corpus branch

Catalogue

 IMDI session

Closed node (sub-components are folded)

Open node (direct sub-components are displayed

 IMDI node that contains data

 Resource without specified resource link

  IMDI node with no data and the number of subnodes indicated.

 Node has optional fields but contains no data

 Written resource

 Video resource
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 Audio resource

Image resource

 Resource is locked and can only be opened by users with access rights.

 Resource is unlocked for the user

Info file

 In resources: archivable file of an unknown type

 File that is not an archivable format and therefore cannot be added as a resource

 The node has been added to the list of the favourites and can be duplicated via the favourites add menu

 Node is currently being loaded

 File not found

 Cosed controlled vocabulary

 Closed multiple vocabulary. Enter multiple values by inserting a comma (,) between separate entries.

 Open controlled vocabulary (text can be selected from a list but new text can also be added)

 Open multiple vocabulary by inserting a comma (,) between separate entries

 Language selection on field (e.g. Description language)
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Chapter 2. Starting Arbil
When you open Arbil for the first time the wizard appears and gives you the ability to configure Arbil to
your needs. The first window is a welcome window, press next to move to the second step of the wizard.
In this window you select the metadata format i.e. IMDI or CMDI; you can choose one of them or both.
In this manual we will assume just IMDI. The third window gives you the ability to choose the corpora

that will appear in the Remote corpus box. If you know the URL1 of a corpus that you will be working on
frequently, you can add it to this list so that it will be available on the root level of the tree in the Remote
corpus box. After finishing with Remote locations press next and then the finish button. You can reopen the
wizard through the help menu by choosing Run setup wizard.

Figure 2.1. Welcome to Arbil

Figure 2.2. Remote locations

Starting Arbil can be done in two ways, either by webstart or by downloading the programme, see here [http:/
/tla.mpi.nl/tools/tla-tools/arbil]. Note that webstart will not work for OpenJDK 7; in this case download the
installer version.

You can copy the URL of a corpus by selecting the node in the remote tree in Arbil when the wizard is not showing, right click and select
'Copy'; or get it from the IMDI browser by navigating to the corpus, right click the node and select 'Create bookmark' and copy the URL link.
Then you can paste it into the box in the wizard.

http://tla.mpi.nl/tools/tla-tools/arbil
http://tla.mpi.nl/tools/tla-tools/arbil
http://tla.mpi.nl/tools/tla-tools/arbil
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Chapter 3. Set-up
3.1. Corpus nodes, sessions and catalogues

It is important to understand the distinction between the following as these elements are essential to the
internal structure of Arbil:

corpus node, 

corpus session

corpus catalogue 

IMDI is organized hierarchically meaning that any number of other corpus nodes can fall under each corpus

node  . These nodes do not describe resources but are meant to construct the corpus structure only. It

is the session nodes  which include information about the actors, content, media file, project, source and
written resources.

A corpus catalogue,  on the other hand, is a general descriptive element of the whole corpus.

3.2. Remote Corpus
The Remote Corpus contains all the corpora located in the archive. Currently it is not possible to add anything
to the remote corpus or edit it in general. It is primarily used to view data and also allows you to import
corpora to the Local corpus (discussed in Section 3.3) where they can then be modified.

It has a tree-like structure in which each node contains multiple sub-branches. To open any of them, click on
the bullet to the left of the node representing the branch or double click the node itself. This can be repeated
for the sub-branches as well. In this way you can view the whole structure of the corpus. If you click the
bullet again, the node will fold back (the Remote Corpus is very similar in use to  the web-based IMDI
browser [http://corpus1.mpi.nl/]).

3.2.1. Adding and removing Remote Locations
If you want to use a corpus that is not available under remote corpus, or want to link it at root level, you can
add it yourself, provided that you know the URL address of the corpus. Right click on the Remote Corpus
top node and choose Add Remote Location. In the pop-up window enter the URL and press OK. The corpus
should now appear in the main list of the Remote Corpus window.

Figure 3.1. Adding a remote location

http://corpus1.mpi.nl/
http://corpus1.mpi.nl/
http://corpus1.mpi.nl/
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Since you might not want to use all of the corpora in the Remote Corpus, it is also possible to remove any
of the locations of the Remote Corpus at the root level so as to only display the corpora that you need. This
can be done at the root level only (see figure 3.1) by right clicking on the node (e.g. for MPI corpora) and
selecting Remove Remote Location.

If you have removed some corpora, it is always possible to re-add them to the Remote Corpus by right
clicking on it and selecting Add Default Remote Locations.

To add a subnode to the root level browse to the desired sub corpus, right click on it and choose Copy. Then
go back to the top node of the Remote Corpus, right click on it, choose Add Remote Location and paste the
URL in the dialogue box. The sub corpus will now appear in the Remote Corpus tree.

The corpus data on the Remote Corpus are frequently updated by researchers. To be sure that you are working
with the newest version of the available data, you can update it manually on the nodes that you believe have
been altered. To do this, right click on the specific corpus/session you want to update and select Reload.
In principle, after new data has been entered into the archive, it can take up to an hour before the Archive
is updated.

3.2.2. Viewing Remote Corpus Information
In general, the easiest way to view the information of a node is to drag and drop it from the remote corpus
into the grey working area on the bottom right. It is also possible to right click on the selected node and
chooseView Selected. In either case, a window pops up with the desired information listed in tables. This
can also enable you to view multiple nodes at the same time.

To compare multiple nodes, simply hold Ctrl while clicking on the desired nodes. Then drag them to the
working area (or right click and select View selected). You will get a similar scenario to this displayed in
the figure (3.2) below.

Note: If you have an existing open table, it is also possible to add additional tree nodes of any form (i.e.
sessions, corpora and files). Simply drag any unselected node from the tree structure and drop it on the table.
It will be automatically added to the table as a row.

Figure 3.2. Viewing multiple selected corpora

There are also two other quick ways for viewing corpus/session information.

(1) Let your cursor rest above a corpus or session node without clicking. Information about the corpus/session
will be displayed in the tooltip under the cursor.

(2) Click on a corpus/session node. Information will be shown up in the top right frame.

When viewing information on multiple corpora, each row corresponds to one corpus, while each column
corresponds to one metadata element (data category). By clicking on any of the column names, you can
easily sort rows alphabetically within a given table.
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In a table that includes several different types of nodes (such as sessions and corpus nodes as listed in the
table below) notice that not all the elements of the corpus structure are described in terms of the same data
categories (column); for example, there are data categories that belong to a session but not to a corpus node.
Such data fields are marked in grey and are not available this is also the case in the Local corpus (see Section
3.3).

Figure 3.3. Not editable cells in a table

In some cases you will see that instead of a value in a cell in the table there is a caption: <multiple values>.
This means that there is more than one value for this data category for this particular node. To see these
values click on <multiple values> and a new window will pop up with the information shown.

3.3. Local Corpus

The Local Corpus  is located beneath the Remote Corpus pane in the Arbil left frame. Remember that the
Local Corpus is the main working area and that changes made in the Local Corpus will not affect the Archive.
The Local Corpus serves two main functions: 1) Edit existing corpora, 2) Creating new Corpora. Section
3.3.1 explains how local corpora may be modified by either (re)editing the data from the Remote Corpus.
Section 3.3.2 explains how to create and subsequently modify new corpora, session nodes or resource files.

3.3.1. Import to Local Corpus

If you have decided to work on a corpus from the Archive you first need to import it from the Remote Corpus
to your Local Corpus, and then you can edit it. To do this, locate the node/session from the Remote Corpus

and simply drag the item and drop it into the local corpus icon . You can also right click on the corpus
node you want to import and choose Import to Local Corpus. In the dialogue box that pops up you can check
the Show Details and Options box in order to:

(1) Overwrite Local Changes : Overwrite an existing local corpus/session node from the same original
location. When is this option useful? Consider the likely scenario that you have imported a node from the
Remote corpus and started editing it. If you want to reset the changes, you can reimport it from the Remote
Corpus and check the overwrite local changes box. You can apply this option to every branch of the corpora.
To do so, first checkShow details and options box; in the window that appears select the function Overwrite
local changes.
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Figure 3.4. Show details and options

Figure 3.5. Overwrite local changes
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In the case that you have uploaded a corpus from your local corpus to the Remote Corpus and you want to
edit it again, editing should not be done in the already existing file in your Local Corpus. In this case you
have to reimport the corpus from the Remote Corpus where your uploaded it before via Lamus.

(2) Copy Resource Files: Import resource files to your computer. Please be aware that copying the resource
files may take some time and will use disk space on your computer. When you press Start, the branch will
be copied to your Local Corpus tree. The process can be interrupted by clicking Stop. Note that Arbil cannot
deal with resources that need authentication.

Figure 3.6. Importing a corpus branch to Local Corpus

3.3.2. Creating corpus and session nodes
Instead of copying an existing corpus or corpus nodes from the Remote Corpus, you can also create your
own corpus or add session nodes in the local corpus. Moreover, you can also add a catalogue in which the
general information about your corpus will be stored.

To do this, select the top node of the Local Corpus (corpus node), right click it and select the option Add >
Catalogue, Add > Corpus or Add > Session. See Chapter 4

3.4. Working Directories
Beneath the Local Corpus window, you will find two different tabs: Files and Favourites. This section
describes Files and its Working Directories while Section 3.5 focuses on Favourites. This window is
responsible for linking a folder from your computer to Arbil so that media files can be transferred into your
corpus. It is advisable to have one or more folders on your computer that contains all the necessary files
that you would like to upload to your corpus. This way, you can simply link this folder and retrieve all the
necessary files.

The option Files is selected by default. Its Working Directories are meant to keep at hand the resources
that you want to add to your corpus (such as annotations, audio files, pictures etc.). To add a new Working
Directory, right click on the Working Directory node and select Add Working Directory. Now browse to the
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directory you want to add, select it and click Open. In the figure 3.8, the directory "Recursion pics" is about
to be added to the Working directory, so as to access the media files present in this folder.

Figure 3.7. Add working directories

After linking a directory to Arbil, you will have access to the folder. To import the media files (e.g..
Droste.jpg) to a session of a corpus, simply drag and drop them into a session of a local corpus.

Figure 3.8. Linked folder

Note: If you right click on Working Directories, you will also see that it is possible for Arbil to show you all
hidden files (option Show hidden files). This option is useful when you want to include corpus files which
are normally hidden in your file manager.

Browsing through Working Directories is very similar to browsing through the Remote or the Local Corpus.
To open/close a folder click on the bullet or double click on its name. If you have added or modified the
content of a directory outside Arbil, by right clicking on the Working Directory, you can update its content
in Arbil (the Reload option).

Viewing file information is done in the same way as it has been described in Section 3.2.2. (Viewing Remote
Corpus Information). Remember that if you place the cursor over a file, an information window will appear
that will give you a file description, including the information about whether the file is archivable or not.
Archivable files can be uploaded to the server. Image 3.7 shows an example of an archivable file:
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Figure 3.9. Archivable file

Editable files from the Working Directory can also be opened by external applications. Right click a given
file (e.g.. audio file, picture) and select Open in External Application.

If the file is not archivable, the  icon will appear. If you hold the mouse pointer on the file, you will see
the following information:

Figure 3.10. Unarchivable file

For the list of accepted file types and formats, check the LAMUS manual [http://www.mpi.nl/corpus/html/
lamus/apa.html].

A file that is not supported by Arbil can be kept in Arbil and still be added to a Session, overriding the
decision of the internal type checker. Right click on it and select Override Type Checker Decision, a pop up
window will appear where you have to choose if this is a media file or a written resource; the  will then
change into an icon of either a Media file or a Written Resource file and can be added as a resource file. To
open the file right click it again and select Open in External Application. Beware that overriding the type
checker decision can cause your corpus not to be accepted into the archive (rejected by Lamus).

3.5. Favourites
The tab Favourites is meant for storing session elements that you would like to re-use in new sessions,
such as actor, language elements, location etc. Session elements that can be saved in Favourites are: IMDI

sessions ( ), actors, content elements etc). If you have a number of elements in your Favourite List and
you are not certain what the content of a given element is, you can always place the cursor over it and wait
for the tool tip (information window) to appear.

Figure 3.11. Favourites List

http://www.mpi.nl/corpus/html/lamus/apa.html
http://www.mpi.nl/corpus/html/lamus/apa.html
http://www.mpi.nl/corpus/html/lamus/apa.html
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3.5.1. Adding elements to favourites
In order to add an element from the local corpus to the Favourites List, right click its node and choose Add
to Favourites List. The element now appears in the Favourites List. You can also just drag them from the
corpus tree structure, right down to the Favourites List. If this element is needed again, you can place it into
a preferable location in your Local Corpus either by dragging it from the Favourites list or Copy/Paste it in
one of the Local Corpus (sub)branches.

Figure 3.12. Adding to favourites via menu

3.5.2. Adding Favourites to other elements
The items in the Favourite List can be viewed and edited in the same way as the elements of the Local
Corpus (right click and View/Edit Selected). This means that if you make changes to your favourites you
have to right click on them and select Save Changes to Disk to make them permanent (or use Ctrl/cmd+S).
The favourites which have been edited turn in blue which indicates this element still has to be saved locally.

Once you have completed your Favourites list, you can start using it. Let's say you want to add a particular
Actor to a session - in order to do this choose the session in question, right click it and choose Favourites,
Add from Favourites and click on the right actor. You can also do this by "drag and drop".

Figure 3.13. Adding favourites to a Session
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Chapter 4. Editing the corpus
structure

This chapter focuses on how to develop the structure of the Local Corpus.

4.1. Adding a new corpus node
Once you have created/imported a corpus, you can add new corpus branches to any corpus node of the Local
Corpus. To do this, right click on a corpus node, scroll down to Add and choose Corpus. A new corpus
(Standard Corpus) will be created in the tree structure directly under the node you clicked on. Notice that
at the same time a window pops up, in which you can edit the metadata of the new corpus node (such as
corpus name etc.).

Figure 4.1. Adding a new corpus branch

4.2. Adding a new session node
In addition, a new session node can be added to each corpus node. Right click on a corpus node, scroll down
to Add and select Session (figure 4.2). A new session will be created in the tree structure directly under the
branch you have clicked on. Notice that at the same time a window pops up, in which you can again edit
the metadata of that session.

Remember that media files can only be added under Session nodes. For a more complete description on how
to add media files to sessions, see Section 4.7.
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Figure 4.2. Adding a new session node to a corpus branch

4.3.  Adding a new catalogue node
The catalogue node is generally meant to provide extensive information about the corpus and its sub-
branches (remember that the metadata window of a regular corpus node only contains three fields to begin
with). In this node you can insert various types of information about your (sub)corpora. It is available only
for the corpus nodes, not the sessions. An example of all the fields contained in a catalogue is displayed
below. It is highly advisable to create a catalogue for corpora! To add a new catalogue to a corpus branch,
right click a corpus node, scroll down to Add and choose Catalogue. A catalogue will be created in the tree
structure directly under the node.
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Figure 4.3. Catalogue

Note:A corpus node can only have one catalogue. If you already have a catalogue and decide to create a
new one, your old one will be replaced by the new one.

4.4. Adding other components
As shown above, you can add session nodes and catalogues to corpus nodes. Moreover, you can also add
additional elements to session nodes and catalogues. If you right click on a catalogue > add, you will see
a list of items available in the context menu. Notice how some elements have the  icon, whereas others

have a icon . The  icon represents a component that will be displayed in the hierarchy whereas the 
icon adds a new field (discussed below).
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Figure 4.4. Catalogue context menu

4.5. Adding more field components
Generally, every corpus/ session/ catalogue contains a particular set of fields which can be edited. Adding

 elements implies adding a new metadata field to the selected node.

Figure 4.5. Standard field name

For example, the standard field name includes one field for author. You might want to add an additional
'author' field. To do this, right click on a catalogue, Add > (e.g.. Author). Some fields can be added multiple
times, others can be added only once.
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Figure 4.6. Add new metadata field

4.6. Add field with custom name
In case you want to add a field with a custom name to a node in a session right click on the node name
in the tree structure and select Actor Key (in the example of an actor node). The new field appears as
Keys.Key.Standard Template Key in the list of the field names. In order to change the name of this new
field right click on it, choose Open in External Editor and right-click the Change key name button and then
OK. After you have changed the name, click on Apply for the name to change. Note that the new name
will always start with Keys.Key., which is there by default. Only key fields can have their name changed.
Note that you can add a field with a custom name (key option) only in Session, Content, Actor, Media File,
Written Resource and Source.

After you have added and customized the new key field(s) and you wish to use it other nodes, you can create
a favourite for this node so that you can re-use it instead of repeating the whole process for every new node.

4.7. Adding resource files to a session
There are two ways of adding resource files (e.g. audio, video etc.) to a session:

(1) The easiest way is to drag and drop a given element from the Working Directory to a session node. All
information about the resource (e.g.. its size, type etc.) will be filled in automatically.

(2) It is also possible to add it by right clicking on a session node and choosing Add >Media File or Add
> Written Resource. In the latter case however you will have to fill in manually the location of the file, its
media type, format and size in the window that will appear.

Note that not all file types are archivable. If a file is not archivable, you will not be able to drag and drop
it (any problem with the file will be illustrated by the  icon).
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Figure 4.7. Adding a written resource by dragging and dropping

Figure 4.8. Adding a media file via the menu

It is also possible to add resources, either from a remote location, i.e. the archive or the web, manually.
This can be done by right clicking on a node that supports a resource location (IMDI media file or written
resource) select "insert manual resource location" and add the URL in the window that appears.
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Figure 4.9. Insert manual remote resources

4.8. Moving corpus and session nodes
Arbil allows to move both corpus and session nodes from one location to another. To do it, select in your
Local Corpus a corpus/session you would like to move and drag and drop it to the new location. It is also
possible to move subnodes of sessions, e.g. Actors, across sessions.

4.9. Deleting corpus elements
In order to delete corpus branches, sessions or session components, right click on a chosen element and
select Delete. If you want to remove several elements at a time, choose them all while holding the Ctrl (or
Shift) button. Right click on the selected elements and chose Delete. In each case you will have to confirm
the deletion.

4.10. Saving changes
The changes to your files are not made automatically. You have to save them yourself. To save the changes
made in your local corpus, right click on the node and choose Save Changes to Disk or use the key short
cut (i.e. Ctrl+S/cmd+S).
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Chapter 5. Editing the metadata

5.1. Editing one cell
To edit a corpus or session just click on it (A), or select it and choose view selected (B). In the window
that appears, click on the field you want to change. Type in the new value and press Enter to go to the next
value. If the value you have typed is too long for the cell, the long field editor will open automatically in
order to edit this value.section 5.2

Figure 5.1. Editing

Some of the cells have either an open ,  or a closed , vocabulary (figure 5.2). In both cases
when you double click the field you need, a drop-down menu will appear showing you available default
values. In the case of open vocabulary fields, you are permitted to type your own value (if, for example, you
would like to have "grandfather" as a family role but you cannot find it in the list). In closed vocabulary
fields, however, it is only possible to choose from the list (e.g. sex: male/female). Notice that when you
enter a value that is incorrect, the text will be shown in red; otherwise it is in blue. In the case of  you
can add multiple values (either from the drop down, or your own) by inserting a comma (,) between the
values (typing the first letter of the new value will offer a suggested value from the drop down). In controlled
vocabulary fields 'type-ahead' functionality is available; to confirm a suggestion, press ENTER or type a
comma in multi-CV to add another value.
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Figure 5.2. Closed vocabularies

In some descriptive elements, you will also see a drop-down menu from which you can choose a language
which you use to describe the data information. To do so, click in the right corner of the field.

Figure 5.3. Choosing a language, click on desired language

5.2. Long field editor
The Long Field Editor (LFE) allows the user to edit long values, such as descriptions. The LFE works either
automatically or manually. In the case you want to add a long description in a cell you can right click on
the field in the table and select Open in Long Field Editor. In the window that appears you can add and
edit the text. In the case that a field already contains a long value and you wish to edit it, double click on
it; the LFE will open automatically.

The LFE can be opened on a selected node by right clicking on it and selecting View/Edit in Long Field
Editor. The LFE opens on the first field under the node, you can then navigate in the fields by using the
previous and next buttons (1). The field you are currently in appears on the top of the LFE (2). The text
appears and can be edited in the white area (3).

Changes made in the LFE get applied to the field as soon as the LFE is closed or by pressing the previous
or next buttons.
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Figure 5.4. Long Field Editor

5.3. Editing multiple cells
It will often be the case that a piece of information (e.g.. continent, country, address etc.) has to be repeated
across the sessions. Instead of typing this data in every session, you can copy-paste it at once into all the
relevant fields. Choose the relevant sessions by holding Ctrl and clicking on them. Then right click one of the
selected items and choose View/Edit. You will see a window appearing in which you can edit the sessions.

To edit the selected sessions, take the following steps:

1. Fill one of the session fields / choose a default value from the drop-down menu that you need (e.g.
Country). If one of these session fields is already filled in with the relevant information, skip this step.

2. Right click on one of the selected cell and select Copy.

3. Select the fields where you want to paste the copied information (one by one) by holding Ctrl and clicking
on them. Right click on one of the selected fields and chose Paste.

Figure 5.5. Pasting data into multiple cells

If you want to copy a value into all the cells of a certain column, select the field you want you copy, right
click it and chose Copy Cell to Whole Column. All the cells in the column will be changed accordingly.
Note, however, that this option is only applicable to one column at a time.
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Figure 5.6. Copying the value of a cell to all the cells of a column

It is also possible to simultaneously copy-paste values to multiple columns. To do that, while holding Ctrl
(or cmd), select the relevant cells of a metadata file, right click one of them and choose Copy.

Figure 5.7. Copying values from columns in one metadata file

Now choose the cells within the selected columns in to which you want to paste the copied value by Ctrl (or
cmd) clicking on them (you can also draw a box over them with the cursor), right click one of the cells and
select Paste. The values will be pasted into the appropriate columns.

Note that you cannot copy-paste data from different rows, only from different columns.

Figure 5.8. Pasting values from two columns into several metadata files

5.3.1. Find and Replace

Another option in editing cells is the Find and Replace option activated by pressing CTRL+F when in a
table, or by right clicking on a cell and selecting "Find/Replace". In this case a line appears at the bottom
of the table with two boxes (figure 5.7); the left box is used to define the term you intend to find in order to
replace. Replacing is not done by typing in each cell you intend to change, but by adding the new term in
the right box. By pressing the Find Next key the term specified in the first box is highlighted in the table,
you can either change it by pressing the Replace Selected key, or skip it and move to the next by pressing
Find Next. Once you have moved to the next term in the table, you cannot go to a previous. In that case you
will have to select a previous cell to start from and continue searching.
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Figure 5.9. Find and Replace

5.4. Editing All Metadata of a Subnode
It is also possible for the user of Arbil to get access to all metadata under a node in a hierarchical order
(figure 5.10), as the order of the (sub)sessions, so as to edit them. To do this, right click on a session on the
tree view and select "edit all metadata" (this function cannot be used on Corpus nodes). Editing can be done
in all cells in the way it has already been described.

Figure 5.10. Edit/view all metadata

5.5. Customizing Column Views
When viewing/editing multiple elements in a table, sometimes there are a lot of columns to go through.
It is possible to reduce them by choosing which columns you want to see or which columns you want to
hide. Right click the header of any column i.e. "Name" and select the option Edit This Column View. In the
window that pops up, you can select columns that you want to show (Show Only) or hide (Hide) (if you
check only the Hide column, the unchecked names will appear in the window). It is important to know that
the column(s) which disappear from this particular window, are not removed from the corpus itself.
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Figure 5.11. Choosing columns

So let's say that you have Date and Description marked as Show only (figure 5.12). This means that if you
would now use this window to check out a node that has other categories than the ones selected with the
option Show only, then these categories will not be displayed. So the window in this particular example will
only have two columns.

If you have a table with: Name, Title and Description and you set the Description to Hide, it means that
Description will never be shown. But if the elements that you add to the window have other categories, these
will still be displayed and the number of columns will increase accordingly (assuming that you don't use
the show only option).

One more option of customizing the column view is the function Limit View to Current Columns, which you
will find by right clicking the header of a column. When chosen, this mode will freeze the current columns
view, meaning that no matter what element you add to the window, only the current categories (columns)
will be shown.

It is also possible to set the width of the columns by dragging the right or left edge of the column. This
applies to arbitrary open tables as well as saved column views.

Figure 5.12. Editing column view

It is also possible to hide a column from the current view. To do this, right click the column that you do not
want to be displayed and choose This column and then Hide Column.
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Figure 5.13. Hiding one column

Once you have hidden the unnecessary columns, you can save this view by right clicking any of the headers
of the columns and choosing Save Current Column View. Give the column view a name and select OK.

Figure 5.14. Saving Column View

Currently it is not possible to delete the column views that you create.

The view you have just saved is also applicable to other tables. Right click the header column of the new
Table, select Column View for this Table and choose the view you want. By default, there are two views
already defined and cannot be modified: All (i.e. all columns are displayed), and Minimal (i.e. displaying
only Name, Title and Description). It is important not to forget that each view you create initially is window
specific. In this way you can use different views for different windows.

It is also possible to set your modified column view as the default column view that will appear in all tables
you open. To do this go to options in Arbil toolbar, scroll to Column View For New Tables and then select
the preferred column view. This is now your default column view. (figure 5.15/1).
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Figure 5.15. Setting new default column view

Note: Column views that have been modified and multiple open windows in the working area, either saved
or unsaved, are available after closing Arbil once the programme starts again exactly in the same way they
were before closing it provided the Save Windows on Exit is activated in the Options menu (figure 5.15/2).

5.6. Highlighting cells with the same value
If you want to see, which cells in a table have the same value, right click the appropriate cell and choose
Highlight Matching Cells. Cells with the same value will be highlighted. You can do this with more than
one cell - each new group of matching cells will be given a different colour. To remove the highlight, right
click on a cell and choose: Clear Cell Highlight, which is visible in the above figure as well.

Figure 5.16. Highlighting cells
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Chapter 6. Searching
6.1. Searching Local Corpus

The search option allows you to find a value(s) throughout either the Local Corpus or the Remote Corpus
(paragraph 6.2). To do that, right click on a given node you want to search in and select Search (you might
also choose a number of nodes by holding Ctrl and clicking on them). A window will appear in which you
can specify where exactly you want to search e.g. within Corpus, Session, Catalogue, Actor etc.

Figure 6.1. Selecting search locations

In the search window you can further specify in which column you want to search. By clicking on column a
drop down list appears which contains pre-defined common values and previously entered column names;
it is also possible to add any column name to this list, or remove arbitrary items by selecting the value and
pressing shift and delete; deleted values again have to be retyped and searched for in order to appear in
the drop down list again. After specifying the column (i.e. Name), give the value name you look for, e.g.
"Blance", and click on Search.

By selecting either Equal ( ) or Unequal ( ), you will need to specify whether your search results
should match the word you filled in or rather show you where this word does not appear.

6.2. Searching Remote Corpus
In the first row of the remote search it is necessary to specify what you are looking for in the remote corpus
so that the search will be narrowed down within the remote corpus (figure 6.2). The results based on the
first row provide all the nodes from all the sessions with this term (green box below). These results can be
reduced by specifying more values in the second search row (red box). After specifying values in the second
line searching in the remote corpus is similar to searching in the local corpus.

Figure 6.2. Searching Remote Corpus
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Chapter 7. Exporting and Importing
data

7.1. Exporting data from Arbil
After creating new corpus branches or editing corpora from an already existing archive, you can save your
files and upload them to the appropriate archive. In order to do this you need to export your files from Arbil.
To do this select the modified nodes or a branch that contains the modified parts, right click them and select
Export. A dialogue box will pop up, in which you choose the location of the export and the name of the file.
To complete the export, click on Export Branch Destination Directory.

Figure 7.1. Exporting files

The following message will appear:

Figure 7.2. Export alert message

Selecting OK will lead you to a new message window where, before clicking on Start, you can chose the
option Show Details and Options:
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Figure 7.3. Export window with details

The options Rename Metadata Files and Limit Characters in File Names are already checked. The option
Copy Resource Files are explained in the import to Local Corpus section (3.3.1).

7.2. Importing data into Arbil
In Arbil there is a number of possibilities to import the data. The first way to import data is from the Remote
corpus to the Local corpus by right clicking on the remote corpus and selecting import to local corpus, or
by "drag and drop".

In the case you want to import data from you local computer disk, or the network, you can do this from the
menu bar by going to Files, Import and then selecting the data from your local disk, or the network; your
data is imported at the root level.

Import Branch (i.e.. importing a piece of your corpus) gives you the ability to import part of your corpus
from your disk to the Local corpus. Reimport (i.e.. re-importing form the remote corpus): in order to make
changes to a corpus you have already exported to the Remote corpus via Lamus it is essential to reimport
it to the Local corpus and select overwrite changes.

Import CSV (i.e. in the table format) gives you the ability to import edited data in the Local corpus in the
form of a table (for details see section 7.3 below).

7.3. Using an External Editor
As has been noted already, it is possible to open, view and modify the data using external editors such as
spread sheets or text editors. Overall the process is done by moving data from Arbil to the external editor,
making the necessary changes, and then moving them back to Arbil.

Moving data back to Arbil however posses some restrictions; for example, if you copy multiple rows in
a table, the data format cannot be pasted back into Arbil. However it can still be viewed and edited in an
external editor. For this reason after editing data in an external editor, such as Microsoft Excel, you can
save you your data in csv format, and then import them to Arbil by right clicking on the preferred node and
selecting import CSV. This way gives you the ability to import the data in a table format; in any other case
you will have to import the edited data column by column, but not all at once.

If cells in a table corresponding to a single metadata file are copied, then the data will be in a format that
can then be pasted back into any table in Arbil, provided that the data maintains the same formatting.
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To open data in an external editor i.e. Ms Excel, select and copy the data from the table , then paste them
in the editor you wish to use.

Figure 7.4. Editing data in an External editor

7.4. External application
By selecting Open in External Application you can view, and edit, resourses and metadata in the application
that your computer chooses by default, such as a media player for a video file, or a text editor for a text file.

Figure 7.5. Viewing data in external application
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Chapter 8. Exiting Arbil
Before exiting Arbil make sure that you have saved all your changes. This can easily be done by the key
short-cut CTRL+S.

You can exit Arbil by closing the main window, or through file -> exit on Wi§ndows or Linux, or Arbil ->
quit Arbil on Mac OS. In case of unsaved changes a message will appear and ask if you wish to save changes
before exiting; choose yes or no, Arbil is now closed.
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Chapter 9. Shortcut Keys
In Arbil you can use the following shortcuts:

Table 9.1. General shortcut keys

CTRL/CMD+A Select all

CTRL/CMD+F Find & Replace

CTRL/CMD+S Save

CTRL/CMD+W Close topmost window

CTRL/CMD+SHIFT+W Close all windows

CTRL+TAB Next window

CTRL/CMD+SHIFT+TAB Previous window

CTR+P Hide/Show the selection preview

ENTER (in the tree) Open the current tree selection in a table

DELETE (in the tree) Delete the selected node from the tree

Table 9.2. Table short cut keys

CTRL/CMD+A Select all

CTRL/CMD+C Copy

CTRL/CMD+V Paste

CTRL/CMD+Z Undo

DELETE Delete the contents of the current table cell and start
editing

ESC Cancel editing of the current cell

CTRL+ENTER Edit a cell in a new window


